
COP2170 Visual Basic ASSIGNMENT SHEET for Professor Floyd Jay Winters v01/08/2022 

#1 (Intro) | #2 (Boxes) | #3 (Calcs) | #4 (Format) | #5 (If) | #6 (Loops) | #7 (PMT Func) | Mid| #8 (Anim) 

#9 (Pass Arguments) | #10 (Add Forms) | #11 (Menus) | #12 (Arrays) | #13 (Files) | #14 (Docu) | Final 

 

Please do Not print. I may add some helpful additions and hints and put this back online. 

The key to Success is just showing up. If you miss a class, it makes this subject much harder! 

 

ASSIGNMENT #1 – You first Visual Basic Form – Start your Invoice Program 

Read Chapter 2 in your Visual Basic textbook 

Starting Out With Visual Basic 8th Edition By Gaddis & Irvine, ISBN-13: 978-0-13-520465-8 

This book is based on Visual Studio 2017: https://visualstudio.microsoft.com/vs/older-downloads/ 

The download file was named: vs_Community.exe. I saved it to my Downloads folder. 

I strongly suggest you make a folder in C:/ and on your USB drive named vb. (C:/vb) See step 4 below. 

 
To start a new project also see Page 54 in your text book. 

https://www.bkstr.com/scfbradentonstore/course-materials-results?shopBy=course&divisionDisplayName=&departmentDisplayName=COP&courseDisplayName=2170&sectionDisplayName=B01&programId=4075&termId=100072282
https://www.amazon.com/Starting-Out-Visual-Basic-8th/dp/0135204658
https://visualstudio.microsoft.com/vs/older-downloads/


Or once everything is installed, File > New Project…  

 
 

See the YouTube link below to build a simple Payroll Calculator 

https://www.youtube.com/watch?v=-LTumY6SwnM&t 

However, your assignment is to build a similar Invoice Program form with the Labels shown on the left. 

 
 

10pts Set the Form Title and your Name in TitleBar at the very top [p45] 

10pts Add the main Labels to the form [p47] or from video 

10pts Under the Label Name property use good object names lblDescription, lblPrice, lblQuantity.., 

10pts Add the main Textboxes to the form (Make Subtotal is a Label – so not one can enter there) 

10pts Under the Label Name property use good object names txtDescription, txtPrice, txtQuantity.., 

10pts Use at least two noticeably different Label Fonts and label Colors [p70] 

10pts Add a Button for the calculation routine, with a good name starting with btn. [p47] 

10pts Neatly Left-Align the main labels and all the textboxes and set them to consistent sizes. [p72] 

10pts Make sure the calculation works correctly (see video) 

10pts Add 3 Comments at top of code view to display Program Name, Author Name, Creation Date [p98] 

Due: Beginning of class, 2nd week. This will be graded in class on your USB drive, which is required.  

https://www.youtube.com/watch?v=-LTumY6SwnM&t


         -5 points for each day late or -25 points per week (There is extra credit to make up for late work) 

DO NOT SAVE after you start your project. VB automatically Saves whenever you click Run. You can 

NOT SAVE projects created on your hard drive to your USB thumb drive. But you can COPY the entire 

folder from your hard drive to the USB thumb drive and vice versa. Make backups: Ctrl C | Ctrl V 

 

NOTE – Each week in class I work on the next week’s assignment. Each student is expected to pay 

attention to what we are currently doing in class. Students are strongly encouraged to do the currently 

in-class project that I am working on at their own computers. However, some students use our class 

time to do the prior week’s assignment. That is the recipe for failure because you will only fall much 

further behind because you will miss out on the code and solution for your next assignment.  

DO NOT WORK ON THE PRIOR WEEK’S ASSIGNMENT IN CLASS, unless I set aside time for that. 

 

ASSIGNMENT #2 – Improving your Invoice Program Form Continue Chapter 2 in your textbook 

Continue with your project and add the following to Assignment #1. Save it with the same name. 

10pts Backup your project on your USB drive: Ctrl C, then Ctrl V – But do Not work with the backup. 

10pts Add a different Border Style to the Subtotal textbox. [p71] 

10pts Set Autosize to false for the Subtotal textbox [p71] 

10pts Add a PictureBox with a good object name and with a Logo [p82] 

10pts Add a btnHide in the lower left corner to hide the logo Picture box: Visible False [p90] 

10pts Add an Exit Button in the lower right corner (Me.Close or End) [p95] 

10pts Add a MessageBox that displays “Thank You” when the Calculate Button is pressed [p104] 

10pts Add a StatusStrip at the bottom of the form that displays the last Calculation total [p105] 

10pts Add a Button to Clear the form textboxes (put it in middle of the bottom of the form) [p75] 

           txtZ.Clear or txtZ.Text="" or lblZ.Text = String.Empty 

10pts Add a 3D FormBorderStyle [p108] 

Give your form a good logical name, such as frmMainEntry in VB and Invoice.vb on the drive [p430] 

Due: Beginning of class, 3rd week. This will be graded in class on your USB drive.  

 

GOOD DEBUGGING PRACTICES: 

a. Make the problem as simple as possible. For instance, create a short project named Junk.sln with 

perhaps just 2 text boxes and a button to test your code before adding it back to your real project. 

b. Insert Breakpoints (click in gray side bar to get red circle) then run program, tapping [F8] or [F11] to 

step through (We’ll cover this in class, but you can Google it :-) 

c. Use VB Help or do a Web search for help or sample code or ask for solutions. 

 

ASSIGNMENT #3 – Variables and Calculations as you continue your Invoice Form, Chapter 3 

10pts At the top of your form, add a label and a Textbox for First Name. 

……….At the bottom of the form, add a Label to display “Welcome” txtFirstName (Concatenation) [p128] 

10pts At the top of your form, add a label and a Textbox for Date 

……….At the bottom of the form, in the lblWelcome label display the date in the second line (Crlf) [p128] 

10pts Define (Dim) a Variable named strCompanyName and assign it a value [p132] 

……….At the bottom of the form, in the lblWelcome label display the Company Name in the third line 

10pts At the bottom of the form, add a button to display all three Welcome lines 



10pts Convert txtPrice to decPrice. (CDec) Convert txtQuantity to intQuantity (CInt) [p134] 

10pts Define a Variable named decTaxRate and assign it a value of .07 [p151] 

10pts Calculate Subtotal: multiply decPrice times intQuantity, place the results in the lblCalcSubTotal 

10pts Add a label named lblTax. Calculate Tax and display it in a label named lblCalcTax 

10pts Add a label named lblTotal and add Subtotal to Tax and place the results in a lblCalcTotal label 

Neatly line up all the labels above, so it looks like the lines below: 

 

Subtotal:    100.00 

Tax:                 7.00 

Total:        $107.00 

10pts Turn on Option Strict to make sure the data conversions are correct [p145] 

 

Please use the following variable, textboxes, and label names below: 

frmMainEntry 

strCompanyName 

txtDescription 

txtPrice 

txtQuantity 

decPrice 

intQuantity 

decSubTotal 

lblCalcSubTotal 

decTaxRate 

decTax 

lblCalcTax 

decTotal 

lblCalcTotal 

 

If you do this, I can make a template that I can use to test your background code at home without having 

to completely rebuild my form for each student. And that way I can provide more help to you. 

Due: Beginning of class, 4th week. 

 

ASSIGNMENT #4 – Formatting your Invoice Form, Chapter 3 

10pts Make sure the Tab Order for the ENTIRE form works (top-down, left-right) [p184-185] 

10pts After pressing Clear, Set Focus to the first text box [p186-187] 

Set and format numeric values on _Lost_Focus or _Leave or _Validating [p838] or _ValueChanged [p839] 



 
10pts Display the Subtotal and Tax with two decimal places, no $ on Lost Focus or Leave or Validating.  

http://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/FormatSamples.htm  

10pts Display the Total with two decimal places, and a $ on Lost Focus or Leave or Validating. [p161] 

           There is a Property to Right Justify numeric values so you can decimal-align your numbers. (2pts) 

10pts Add a Try Catch to your Calculation button [p176] 

10pts Add an error MessageBox to your Try/Catch routine [p181] 

10pts Set the Exit button to work with an Alt +X Hotkey [p187] 

10pts Add a GroupBox with CheckBoxes listing at least 3 categories of items that you may buy [p190] 

10pts Add a formatted DateTimePicker from the toolbar with a Short Date Format [p163] 

See DateTimePicker1 section below for formatting: 

http://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/FormatSamples.htm  

10pts On Form Load set Today’s date as the default date for a lblSysDate in Long Date Format [p192] 

So, there will be both a default Invoice date from the DateTimePicker and a System date (lblSysDate) 

Due: Beginning of class, 5th week. 

 

ASSIGNMENT #5 Decisions/IF Continue the Invoice Program, Chapter 4 

10pts Use an If statement for txtPrice lost focus to see if Price is greater than 1000 [p235-237] 

10pts Test for Nulls ("") for Price and Quantity  
  If txtPrice.Text = "" Then Exit Sub  

10pts If Price is greater than 1000 show MessageBox “Is Price too high?” If yes, set Focus and reenter 
Private Sub txtPrice_LostFocus(ByVal sender As Object, ByVal e As ... 

  If txtPrice.Text = "" Then Exit Sub 

  Dim Response As DialogResult 

  If CDec(txtPrice.Text) > 1000 Then ' Out of Range test 

    Beep() 

    Response = MessageBox.Show("Is Price too High?", "Out of Range", 

MessageBoxButtons.YesNo) 

    If Response = DialogResult.Yes Then  

       txtPrice.Focus() 

       Exit Sub ' Exit and do not execute additional code till data OK 

    End If 

  End If 

  ' If you are done error checking, you can Call your Calculation subroutine here 

End Sub 

10pts If Quantity is greater than 100 show MessageBox “Is Quantity too high?” … 

(10pts) Use an Or operator so you will Not do the Calculation if either Price Or Quantity is blank [p255] 

           See first If statement above for a hint. See Below. 

10pts Create a Private Sub for your Calculations, by typing in code view Private Sub Calcs 
Private Sub Calcs() 

    If txtPrice.Text = "" Or txtQty.Text = "" Then Exit Sub 

http://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/FormatSamples.htm
http://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/FormatSamples.htm


    lblCalcTotal.Text = FormatCurrency(decPrice * intQuantity) 
    ' OR 

    ' lblCalcTotal.Text = FormatCurrency(CStr(CDec(txtPrice.Text) * CInt(txtQuantity.Text))) 

End Sub 

 

10pts Use the Call statement to replace and delete the Calculate button [p382] 
            Call is an optional command used to “call” or jump to another Sub Procedure. Although it is 

optional, it is recommended you use the command Call for code clarity. 

 
Dim Price As Decimal 

Dim Qty As Integer 
  

Private Sub txtPrice_LostFocus(ByVal sender As Object, ByVal e As System.EventArgs) 

Handles ... 
    If IsNumeric(txtPrice.Text) Then 

        Price = CDec(txtPrice.Text) 

        Call Calcs()   
' Call eliminates the need for a Calculation button for immediate results on lost focus 
    Else 
        MessageBox.Show("Enter Only Numbers for Price", "Data Entry Error")  

        txtPrice.Focus() 
    End If ' End IsNumeric 

End Sub 
  
' Note 1: Similar procedure is needed for Qty_LostFocus 
' Note 2: There should also be an Out-Of-Range test for all numeric entry on _LostFocus 

 

10pts Convert txtDescription To Upper on Lost Focus or Leave [p261] 

10pts Make sure both Price and Quantity are Numeric on Lost Focus, Leave or Change [p264] 

10pts Add a GroupBox with two Radio buttons for Taxable or Non-Taxable [p281] 

10pts If Non-Taxable then add an If statement to set the tax rate at 0. If Taxable reset the tax rate to .07 

Due: Beginning of class, 6th week. 

 

ASSIGNMENT #6 Lists and Loops Continue the Invoice Program, Chapter 5 

10pts Create a List Box with a scroll bar to show at least 4 invoice items [p312] 

10pts Add a Purchases Counter (+=1) for each time the Calculate button is pressed. [p322, lines 2 and 6] 

           Put the Purchases Counter in the Calc procedure. Display the counter in a Count Label under Total 

10pts Add a Total Sales Accumulator (+=SubTotal) to add all of the Purchase Prices. [p326] 

           Display the Total Sales Accumulator in a Label under Total, next to the Purchases Counter 

           Ex:        Total Number of Purchases: 3.      Total Sales: $750.00     (Four labels in all) 

10pts Add a Check Box to allow you to check multiple items that may be purchased [p342] 

10pts Add a ToolTip Property to the Exit button “Do you really want to exit?” [p354] 

CREATE A SEPARATE PROJECT NAMED LOOPS 

10pts On Form Load add an Input Box to allow the user to enter an integer for the LoopLimit [p310] 

10pts In the top left corner create a Do While loop to count to 10 [p320] 

10pts In the top right corner create a Do Until loop to count to 10 [p331] 

10pts In the bottom left corner create a For Next loop to count to LoopLimit by Step 2 [p334, p338] 

10pts In the bottom right corner build the For Next loop on p336 

Due: Beginning of class, 7th week. 

 



ASSIGNMENT #7 Functions Build a separate project for a Loan Calculator – see top of page 355  

10pts Add Textboxes to enter txtLoanAmount, txtInterestRate, and txtYears.  

10pts Use the Pmt function to do a monthly payment calculation [p356] Display it in lblCalcPayment. 

           Add a Listbox to display Month   Interest   Principal   Balance calculations 

10pts Add a Header BEFORE a For loop (probably even before the ListBox so it is always visible) to show: 

Month   Interest   Principal   Balance 

10pts In the loop, use a Counter to count and display the month number in the first column (see below). 

10pts Calculate the monthly Interest as you loop and place it in the second column. (see book) 

10pts Calculate the monthly Principal as you loop and place it in the third listbox column 

10pts Calculate the running Balance and place it in the last column (see book and see below). 

10pts Neatly Display only the numbers under the Header as you run the loop. Example:  

Month   Interest   Principal   Balance 

1             185.42     435.52      29564.48 

2             182.19     438.75      29125.73 

If necessary, google how to make the numbers line up under the header in neat columns.  

(Hint "Month" & vbTab & "Interest" &…) 

*** Do NOT display the results the very unprofessional way the book displays the detail on page 357. 

Compare your Loan Calculator results to: 

https://faculty.scf.edu/winters/0ClassFolders/1570Office/SamplesExcel/LoanCalculatorToCompare.xls 

10pts Use an Accumulator to display Total Interest Paid after the loop, at the bottom of the listbox. 

10pts Use an Accumulator to display Total Principal Paid after the loop, at the bottom of the listbox. 

Due: Beginning of class, 8th week. 

 

In class Midterm 9th week: 50 Questions, Multiple Choice. 

After the exam I will work one on one with any students who need help on their projects. 

See Midterm Review Guide: 

http://faculty.scf.edu/winters/0ClassFolders/2170VB/SamplesExams/VB-MidtermStudyGuide.htm  

 

ASSIGNMENT #8 Extra Credit Animation up to 30 points. Chapter 6 

Feel free to do an Internet search for sample code. 

10pts Use a Timer for a countdown (decrement) and for movement after countdown 

Private Sub btnCountDown_Click(ByVal sender As System.Object, ByVal e As...           

           ' This Button will begin Rocket count down and launch 

    Timer1.Enabled = True 

           ' Once Timer1 is enabled, the commands in Private Sub Timer1_Tick 

           will execute on each tick 

End Sub 

10pts Use a Loop to move an object either left to right, right to left or on a diagonal.  

Do Not use the up sample below, but you can use it as a pattern. 

Private Sub Timer1_Tick(ByVal sender As System.Object, ByVal e As ... 

' If you use a background image and the animation causes a white outline 

' as it moves place the animation on a separate form (or use a Panel tool) 

' and then set the Form's Double Buffer property to TRUE. 

    Static C As Integer = 5 

' Static means remember current value as other parts of program are run 

https://faculty.scf.edu/winters/0ClassFolders/1570Office/SamplesExcel/LoanCalculatorToCompare.xls
http://faculty.scf.edu/winters/0ClassFolders/2170VB/SamplesExams/VB-MidtermStudyGuide.htm


    lblCount.Text = C 

    C -= 1 ' Decrement by 1 each timer click 

' Note: a loop is seldom used in a timer, because the timer automatically ticks 

    If C = 0 Then 

        lblCount.Text = "Ignition" : lblCount.ForeColor = Color.Red 

    End If 

    If C <= -1 Then 

        lblCount.Text = "Blastoff" : lblCount.ForeColor = Color.Blue 

        Timer1.Interval = 100 

           ' 100 = 100 ms. - reset Interval to move rocket faster 

        picRocket.Top -= 1 

           ' Move picture up by decrementing the top position 

    End If 

End Sub  

 

10pts Make it really nice and cool! 

Sample submission:  

https://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/Annimation-Submission-Example.jpg 

Due: Beginning of class, 10th week. 

 

ASSIGNMENT #9 Procedures and Functions Continue Chapter 6 

10pts Create a new project and add a Tab Control from the toolbox to the main form. [p831] 

           Add three tabs with valid names and Tab Titles: Pass Argument | Pass to List | Function  

  5pts On the top of the first tab, add a Label to clearly describe what Passing an Argument means 

  5pts Add a second Label to give a specific example for your description of Passing an Argument. 

20pts Under the labels, on the first tab, build something like the Lights Project starting on page 383 or 

feel free to use the Internet to find sample custom procedure that passes Arguments.  

For a simple sample see: 

https://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/Procedure_Arguments.htm 

https://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/Procedure_Arguments.jpg  

10pts Do Not use the samples above. Create your own procedure or find and modify one on the web. 

           Do Not use the light bulb images shown in the book. Use your own images and design 

10pts Put all the code for the first tab in a Region called PassArguments, and the code for the second 

tab in a Region called PassList, and all the code for the third tab in a Region called MyFunction. 

10pts On the second tab, (Pass to List), create a small app like the one shown on page 389 

  5pts On the top of the third tab, add a label to describe what a Function is 

  5pts Add a second label to give at least two specific examples of functions 

10pts Under the labels, create a custom function similar to the one on page 397 or feel free to use the 

Internet to find sample custom VB functions to modify. For a simple sample see: 

https://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/Function.htm - but use another sample 

Due: Beginning of class, 11th week. 

 

ASSIGNMENT #10 Multiple Forms Continue the Invoice Program, Chapter 7 

10pts Add an attractive Splash Screen [p431] (Project > Add Windows Form > scroll to Splash Screen) 

consistent with your overall project design; make the Splash screen your Startup Form [p434] 

https://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/Annimation-Submission-Example.jpg
https://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/Procedure_Arguments.htm
https://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/Procedure_Arguments.jpg
https://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/Function.htm


10pts Link the Splash Screen to the Login form which will link to frmMainEntry (.Show) non-modal [440] 

10pts Add an automatically centered (there is a property) and attractive Login Form to your Project  

(Project > Add Windows Form > scroll to Login Form) consistent with your overall project design which is 

the Startup object for your project. 

10pts Link the Login Form to frmMainEntry with a properly formatted Password (*** there is a 

property) from the OK button. When the password is correctly entered open the frmMainEntry form and 

then close the Login form, frmLogin.Close [p436] 

10pts Use a counter to give the user exactly 3 password attempts to either open frmMainEntry or Exit. 

10pts Add a modal frmAbout.ShowDialog [p440] (Project > Add Windows Form > scroll to Aboutbox) 

linked from frmMainEntry; change the AboutBox content through its properties and Assembly 

information [See Assembly button on page 434] 

10pts Add a modal form frmCalendar to your project. Add a button to link to it from frmMainEntry 

10pts Neatly drag a Calendar Control from the Toolbox to the new form frmCalendar 

10pts Add a separate Module (Project > Add Module) [p451] A module is all code, no objects. Name it 

something like modVariablesAndFunctions. You should put your Public and Constant variables in the 

Module, such as CompanyName, Company Address, TaxRate. You can put your function from your 

previous assignment in the module. Do not use the word Private! Variables defines in a module should 

be Public. 

10pts Demonstrate that the code in the module is used in the frmMainEntry 

Due: Beginning of class, 12th week. 

 

ASSIGNMENT #11 Menus Continue the Invoice Program, continue Chapter 7 [p461] 

Add a working Menu: File (Exit), Format (Color, Font), Help (Notes, About) to frmMainEntry 

10pts File > Exit (mnuFile > mnuFileExit) – See Toolbox > Menus & Toolbars > add a MenuStrip to form 

20pts Add Format menu item > Color (to access the Label Collection Color Dialog Box mnuFormatColor) 
ColorDialog: Changing color for Labels and TextBoxes: 

1. Add a ColorDialog to the Component Tray (drag from toolbox). 

2. You may also choose to add a MenuStrip to the Component Tray. 

Code for SubMenu item “Edit Color” (mnuEditColor): 

Private Sub mnuEditColor ToolStripMenuItem_Click(ByVal sender As... 

  ColorDialog1.ShowDialog() 

  Label1.ForeColor = ColorDialog1.Color 

  Label2.ForeColor = ColorDialog1.Color 

  ‘ Note: this is usually done with a Collection instead of doing one at a time 

End Sub 

The same basic code shown above works for the FontDialog as well. 

20pts Format menu item > Font (to access a Font Dialog box - mnuFormat > mnuFormatFont) 
Combining ColorDialog and FontDialog: 

To combine the ColorDialog (showing 16 colors as a dropdown) with the FontDialog Box, 

use this code: FontDialog1.ShowColor = True 

Add mnuFormatReset  
Private Sub btnResetFont_Click(ByVal sender As System.Object, ByVal ... 

    Dim myFont As New Font("Georgia", 14, FontStyle.Bold) 

    Label1.Font = myFont 

    ' or ctrlFormLabel.Font = myFont (for Collections) 



    Label1.ForeColor = Color.Indigo 

End Sub 

 

10pts Help > View Help (or View Hints) [ Process.Start("NotePad", "../Hints.txt") ] Make Help work with 

[F1] key. Use real help hints such as where are the data files stored, backing up, data validity ranges... 

(There is a property for mnuHelpViewHelp to set F1. It was under Misc) 

(OR: There is a Shortcut Property added when you add a MenuStrip) Help is always last item on the right 

10pts Help > About box to display Title, Description, Author, Creation Date, Version 

10pts Add a Context Menu (it provides a Right-click menu) (Toolbox > Menus & Toolbars > 

ContextMenuStrip) for changing the label collection Color and Font using a Color/Font Dialog Boxes 

Note: Do not reinvent the wheel. Use mnuFormatColor.PerformClick() in mnuCtxColor menu sub to add 

the routine already created in mnuEditColor. 

10pts Add a working LinkLabel (in Toolbox) to a relevant link [ Process.Start("http://website.com 

10pts Put all your mnuXxx procedures in #Region "Menu" in left-to-right/top-bottom order 

Due: Beginning of class, 13th week. 

 

ASSIGNMENT #12 Arrays Continue the Invoice Program, Chapter 8 [p499] 

10pts Use Dims to define your Arrays 

20pts Enter data for at least three items on your main form. Store the data for at least the Description, 

Price, and Quantity fields into at least three 1 dimensional Parallel Arrays (10 points each) perhaps 

called arrDescription, arrPrice, arrQty.  

10pts Calculate the SubTotal (arrPrice * arrQty) (SubTotal does not have to be part of an array) 

10pts Calculate the GrandTotal (GrandTotal does not have to be part of an array) 

20 On your main form, use a Loop to display the three 1 dimensional Arrays and all the totals (ex: 

arrDescription, arrPartCost, arrPartQty) and calculate GrandTotal (an accumulator)  

10pts Use a button to display all three arrays and the subtotal column in a Listbox  

10 Display an aligned Header (use vbTab), the Detail (all individual items), and the Grand total. 

10 Use an Accumulator to display the Grand Total.  

The Listbox will look like this: 

Description Cost Qty Total 

Apples 10.00 10 100.00 

Bananas 20.00 20 400.00 

CDs 30.00 30 900.00 

DVDs 40.40 10 404.00 

    Grand Total $1804.00 

Due: Beginning of class, 14th week. 

 

ASSIGNMENT #13 Files Continue the Invoice Program, Chapter 9 [p573] 50 points Extra Credit 

Click below to see a simple Password File: 

http://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/DataFile-OneLineOfCode.htm  

Group Project in Class 

25pts Write the data from your Invoice frmMainEntry to your USB drive 

25pts Retrieve and display the data from your drive to a separate form (perhaps in a ListBox) 

http://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/DataFile-OneLineOfCode.htm


See textbook or see: 

http://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/StreamWriter-Reader.htm  

Due: Beginning of class, 15th week. 

 

ASSIGNMENT #14 Create a Documentation Packet for the Invoice Program 50 points Extra Credit 

Create a User’s Manual in Word - this is front part of documentation package: 

10pts Table of Contents page and an Introduction page and page numbers (Google it is you must) 

10pts Discuss and show the running Splash Screen and Login form 

Use [Alt] + [Print Screen] or the Snipping Tool (Start > Programs > Accessories > Snipping Tool) to capture 

your project windows, such as Login, Main Entry Form, About... 

10pts Show and discuss the running Main Entry Form 

 5pts Discuss descriptions, defaults, data entry ranges, basic usage, data file description & path 

 5pts Show and discuss Menu options 

No VB code is to be placed in the front section; the front part is only for the users. 

10pts Create a Programmers section with the VB code in last half of documentation, as a separate 

section 

In Microsoft Word, choose Save As to save the Documentation Package as a PDF file to be placed in the 

Documentation Package Dropbox in Canvas. 

For Samples see: http://faculty.scf.edu/winters/0ClassFolders/2170VB/SamplesDocumentation/  

Due: By Sunday of the last week of classes, before Finals Week. 

 

16th Week 

Hands-on Review for Final Exam in Class 

Visual Basic Final Practice  Professor Floyd Jay Winters   Name _________________ 

  

Code a form that is an:  Grade Calculator                                                      Grade  _____   

Input:  Name, Major, Birthdate, MidTerm (textboxes), ExtraCredit (chkbox), Final (label) 

Formula:  Average = Midterm plus Final divided by 2 (remember Aunt Sally!) 

Add a ListBox that lists in the following order:  ART, BIO, CET, HIS 

Put 2 option buttons in a GroupBox/Frame for Male or Female. 

A.  Use Acceptable and Standard Variable and TextBox names. 

B.  Make sure everything runs correctly!  No Bugs!  -5 to -10 Points for any error. 

C.  Check off what you complete on the line to the right of the numbered task. 

You may write on this paper, but turn it in after you are done with the exam. 

KEEP IT SIMPLE - Do not add anything extra and lose valuable time! 
 Instructor 

Checkbox 
Student 

Check 
_____ 1 Insert the MonthCalendar Control on the Welcome/Logon Form (maybe DT-Picker) _____ 
_____ 2 A Login Form that links to the Main Form through an OK Button and cancels on ESC _____ 
_____ 3 Automatically Maximize the main entry form when it opens. (maybe Center Form) _____ 
_____ 4 Add formatted System (long) Date as a label on the top of main entry form  (short date) _____ 

http://faculty.scf.edu/winters/0ClassFolders/2170VB/Notes-VB/StreamWriter-Reader.htm
http://faculty.scf.edu/winters/0ClassFolders/2170VB/SamplesDocumentation/


_____ 5 Add a LinkLabel to automatically go to www.scf.edu  (or any link) _____ 
_____ 6 Display only the Left first 4 characters of the contents of the first alphanumeric TextBox. _____ 
_____ 7 Automatically Capitalize all the contents of the first alphanumeric TextBox _____ 
_____ 8 Numeric check to make sure only numbers can be entered in the 1st numeric TextBox _____ 
_____ 9 Out of Range MsgBox with Yes/No buttons on the 1st numeric TextBox (range: <= 100) _____ 
_____ 10 A NumericUpDown control that makes the second numeric TextBox increase/decrease _____ 
_____ 11 Calculation (such as Average) that works -10 points for a bug here! _____ 
_____ 12 Use Debug to print out “Midterm= ” and txtMidterm and “Final = ” and txtFinal _____ 
_____ 13 An Extra-credit Checkbox that adds 2 points to the Average if checked; no points if not _____ 
_____ 14 Format Command (Format Calculation to 1, 2, or 3 Decimal Places)   _____ 
_____ 15 All Alpha TextBoxes Left aligned, ALL Numeric TextBoxes Right aligned _____ 
_____ 16 A Groupbox surrounding 2 Option (radio) Buttons for Male or Female (or ChkBox) _____ 
_____ 17 ComboBox (3pts) for Major that defaults (2pts) to “CET” even on Clear (or ListBox) _____ 
_____ 18 About Menu Item (Author, Creation Date) works with Alt key (1 pt) (ContextMenu) _____ 
_____ 19 A Color Dialog Box to set the Font of the 1st label on the form (or ForeColor) _____ 
_____ 20 A working Process linked to a Button to use Windows “Calculator” or “Notepad” _____ 
_____ 21 Add a ToolTip to a working Clear command button (maybe any object) _____ 
_____ 22 SetFocus to the first textbox when the Clear button is clicked _____ 
_____ 23 A well labeled Counter that increments when Clear button is clicked (or Accumulator) _____ 
_____ 24 Put graphic ...SamplesGifs/CD.gif in upper right-corner of main form (or Form Icon)  _____ 
_____ 25 The graphic becomes Visible when the checkbox is checked; Invisible when unchecked _____ 

 The actual final may have one or two additional questions such as a Loop or Timer example. 
 

Final Exam Week – Hands-on Final. 

 

[JavaScript 3-month Calendar] 
 

http://www.scf.edu/
http://faculty.scf.edu/winterf/0ClassFolders/2171VB/SamplesGifs/CD.gif
https://faculty.scf.edu/winters/0ClassFolders/2820Web/SamplesJavaScript/JS_3MonthBasicCalendar.htm

